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Dear Candidate,  

 

In preparation for the Graphic Design & Illustration Using Adobe Illustrator CC certification exam, 
we’ve put together a set of practice materials and example exam items for you to review. What you’ll 
find in this packet are: 

• Topic areas and objectives for the exam. 

• Links to practice tutorials and files. 

• Practice exam items. 

We’ve assembled excerpted material from the Adobe Illustrator CC Learn and Support page, and the 
Visual Design curriculum to highlight a few of the more challenging techniques covered on the exam.  
You can work through these technical guides and with the provided image files (provided separately). 
Additionally, we’ve included the certification objectives so that you are aware of the elements that are 
covered on the exam. Finally, we’ve included practice exam items to give you a feel for some of the 
items.   

These materials are meant to help you familiarize yourself with the areas of the exam so are not 
comprehensive across all the objectives.  

 

Thank you,  

Adobe Education 

  

https://helpx.adobe.com/support/illustrator.html
https://edex.adobe.com/visual-design
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Adobe Certified Associate in Graphic Design & Illustration  
Using Adobe Illustrator CC (2015) 

 

Exam Structure 
The following lists the topic areas for the exam: 

• Setting project requirements 
• Understanding Digital Graphics and Illustrations  
• Understanding Adobe Illustrator 
• Creating Digital Graphics and Illustrations Using Adobe Illustrator  
• Archive, Export, and Publish Graphics Using Adobe Illustrator 

Number of Questions and Time 

• 40 questions 
• 50 minutes 

 

Exam Objectives 
Domain 1.0 Setting Project Requirements 

1.1 Identify the purpose, audience, and audience needs for preparing graphics and illustrations. 

1.2 Summarize how designers make decisions about the type of content to include in a project, 
including considerations such as copyright, project fit, permissions, and licensing. 

1.3 Demonstrate knowledge of project management tasks and responsibilities. 

1.4 Communicate with others (such as peers and clients) about design plans. 

Domain 2.0 Understanding Digital Graphics and Illustrations 
2.1 Understand key terminology related to digital graphics and illustrations.  

2.2 Demonstrate knowledge of basic design principles and best practices employed in the digital 
graphics and illustration industry. 

2.3 Demonstrate knowledge of typography and its use in digital graphics and illustrations. 

2.4 Demonstrate knowledge of color and its use in digital graphics and illustration. 

2.5 Demonstrate knowledge of image resolution, image size, and image file format for web, 
video, and print. 

Domain 3.0 Understanding Adobe Illustrator 

3.1 Identify elements of the Illustrator user interface and demonstrate knowledge of their 
functions. 
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3.2 Define the functions of commonly used tools, including selection tools, the Pen tool, and other 
drawing tools, shape tools, and transformation tools. 

3.3 Navigate, organize, and customize the workspace. 

3.4 Use non-printing design tools in the interface, such as rulers, guides, bleeds, and artboards. 

3.5 Demonstrate knowledge of layers and masks.  

3.6 Manage colors, swatches, and gradients. 

3.7 Manage brushes, symbols, graphic styles, and patterns. 

3.8 Demonstrate knowledge of how and why illustrators employ different views and modes 
throughout the course of a project, including vector/outline vs. display/appearance, isolation 
mode, and various Draw modes. 

3.9 Demonstrate an understanding of vector drawing tools. 

Domain 4.0 Creating Digital Graphics and Illustrations Using Adobe Illustrator 

4.1 Create a new project. 

4.2 Use vector drawing and shape tools. 

4.3 Transform graphics and illustrations. 

4.4 Create and manage layers.     

4.5 Import assets into a project. 

4.6 Add and manipulate type using Type tools. 

4.7 Create digital graphics and illustrations using 3D and perspective tools in Illustrator. 

Domain 5.0 Archive, Export, and Publish Graphics Using Adobe Illustrator  

5.1 Prepare images for web, print, and video. 

5.2 Export digital graphics and illustration to various file formats. 
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Overview of Adobe Illustrator 
Watch this quick video titled see what you can create with Illustrator and get to know the industry-
standard vector graphics app that lets you create logos, icons, drawings, typography, and complex 
illustrations for any medium. 

After watching this quick video with your students showing them what they can go on to create with 
Illustrator, you are going to want to introduce them to the workspace. 

 

Illustrator Workspace Overview 

 
A. Tabbed Document windows B. Application bar C. Workspace switcher D. Panel title bar E. Collapse 

To Icons button F. Four panel groups in vertical dock G. Control panel H. Tools panel 
 

• The Application frame groups all the workspace elements in a single, integrated window that 
lets you treat the application as a single unit. When you move or resize the Application frame 
or any of its elements, all the elements within it respond to each other so none overlap. Panels 
don’t disappear when you switch applications or when you accidentally click out of the 
application. If you work with two or more applications, you can position each application side 
by side on the screen or on multiple monitors. If you are using a Mac and prefer the traditional, 
free-form user interface, you can turn off the Application frame. Select Window > Application 

https://helpx.adobe.com/illustrator/how-to/what-is-illustrator.html
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Frame to toggle it on or off. 

• The Application bar across the top contains a workspace switcher, menus (Windows only), and 
other application controls. On Mac, the application bar is available only when Application 
frame is off. You can toggle it on or off using the Window menu. 

• The Tools panel contains tools for creating and editing images, artwork, page elements, and so 
on. Related tools are grouped. 

• The Control panel displays options for the currently selected object. 

• The Document window displays the file you’re working on. Document windows can be tabbed 
and, in certain cases, grouped and docked. 

• Panels help you monitor and modify your work. Panels can be grouped, stacked, or docked. 

Below you will find a list or resources from the Illustrator user guide that will walk you through the 
workspace, tools, and panels of the program. 

• Workspace basics: Here's a description of the various areas, utilities, and tools you see when 
you start Adobe Illustrator. 

• Customize the workspace: learn about customizing the Adobe Illustrator workspace.  

• Create documents: While creating a document, choose from a wide variety of templates from 
Adobe Stock and blank presets. 

• Tools panel overview: learn about selecting, using, and managing tools in Adobe Illustrator. 

• Tools gallery: Illustrator provides many tools for creating and manipulating your artwork. 
These galleries provide a quick visual overview for each tool. 

• Setup multiple artboard: learn how to create, edit, and delete artboards; customize artboard 
names; display rulers; and more. 

• Rulers, grids, and guides: learn about working with rulers, grids, and guides  

 

Introduction to drawing in Illustrator 
Learn about the basic drawing tools and techniques in Adobe Illustrator.  

 

About vector graphics 

Vector graphics (sometimes called vector shapes or vector objects) are made up of lines and curves 
defined by mathematical objects called vectors, which describe an image according to its geometric 
characteristics. 

You can freely move or modify vector graphics without losing detail or clarity, because they are 
resolution-independent—they maintain crisp edges when resized, printed to a PostScript printer, 
saved in a PDF file, or imported into a vector-based graphics application. As a result, vector graphics 
are the best choice for artwork, such as logos, that will be used at various sizes and in various output 
media. 

https://helpx.adobe.com/illustrator/using/workspace-basics.html
https://helpx.adobe.com/illustrator/using/customizing-workspace.html
https://helpx.adobe.com/illustrator/using/create-documents.html
https://helpx.adobe.com/illustrator/using/tools.html
https://helpx.adobe.com/illustrator/using/tool-galleries.html#tool_galleries
https://helpx.adobe.com/illustrator/using/using-multiple-artboards.html
https://helpx.adobe.com/illustrator/using/rulers-grids-guides-crop-marks.html
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The vector objects you create using the drawing and shape tools in Adobe Creative Suite are 
examples of vector graphics. You can use the Copy and Paste commands to duplicate vector graphics 
between Creative Suite components. 
 

About Paths 

As you draw, you create a line called a path. A path is made up of one or more straight or 
curved segments. The beginning and end of each segment are marked by anchor points, which work 
like pins holding a wire in place. A path can be closed (for example, a circle), or open, with 
distinct endpoints (for example, a wavy line). 

You change the shape of a path by dragging its anchor points, the direction points at the end 
of direction lines that appear at anchor points, or the path segment itself. 

 
Components of a path 

 
A. Selected (solid) endpoint B. Selected anchor point C. Unselected anchor point D. Curved path 
segment E. Direction line F.Direction point  

Paths can have two kinds of anchor points: corner points and smooth points. At a corner point, a path 
abruptly changes direction. At a smooth point, path segments are connected as a continuous curve. 
You can draw a path using any combination of corner and smooth points. If you draw the wrong kind 
of point, you can always change it. 

 
Points on a path 

 
A. Four corner points B. Four smooth points C. Combination of corner and smooth points  
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A corner point can connect any two straight or curved segments, while a smooth point always 
connects two curved segments. 

 
A corner point can connect both straight segments and curved segments. 

 
Note: Don’t confuse corner and smooth points with straight and curved segments. 

A path’s outline is called a stroke. A color or gradient applied to an open or closed path’s interior area 
is called a fill. A stroke can have weight (thickness), color, and a dash pattern (Illustrator and InDesign) 
or a stylized line pattern (InDesign). After you create a path or shape, you can change the 
characteristics of its stroke and fill. 

In InDesign, each path also displays a center point, which marks the center of the shape but is not part 
of the actual path. You can use this point to drag the path, to align the path with other elements, or to 
select all anchor points on the path. The center point is always visible; it can’t be hidden or deleted. 

About direction lines and direction points 

When you select an anchor point that connects curved segments (or select the segment itself), the 
anchor points of the connecting segments display direction handles, which consist of direction 
lines that end in direction points. The angle and length of the direction lines determine the shape and 
size of the curved segments. Moving the direction points reshapes the curves. Direction lines don’t 
appear in the final output. 

A smooth point always has two direction lines, which move together as a single, straight unit. When 
you move a direction line on a smooth point, the curved segments on both sides of the point are 
adjusted simultaneously, maintaining a continuous curve at that anchor point. 

In comparison, a corner point can have two, one, or no direction lines, depending on whether it joins 
two, one, or no curved segments, respectively. Corner point direction lines maintain the corner by 
using different angles. When you move a direction line on a corner point, only the curve on the same 
side of the point as that direction line is adjusted. 
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After selecting an anchor point (left), direction lines appear on any curved segments connected by the 
anchor point (right). 

 

 
Adjusting direction lines on a smooth point (left) and a corner point (right) 

 

Direction lines are always tangent to (perpendicular to the radius of) the curve at the anchor points. 
The angle of each direction line determines the slope of the curve, and the length of each direction 
line determines the height, or depth, of the curve. 

 
Moving and resizing direction lines changes the slope of curves. 

 

Note: In Illustrator, you can show or hide anchor points, direction lines, and direction points by 
choosing View > Show Edges or View > Hide Edges. 
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You can also learn how to specify direction line, direction point, and anchor point appearance, and 
more about the drawing modes in the drawing basics section of the Illustrator User Guide. 

For more specific information about the various drawing tools in Illustrator, refer to the links below: 

• Draw simple lines and shapes: learn about drawing basic lines and shapes in Adobe Illustrator, 
including rectangles, squares, polygons, ellipses, stars, grids, and more. 

• Draw pixel-perfect art: learn how to seamlessly align your artwork with the pixel grid. 

• Draw with the Pen, Pencil, and Flare tools: learn the basics of drawing in Adobe Illustrator 
using the Pen, Pencil, and Flare tools. 

• Draw, edit, and re-edit shapes easily: this tutorial shows you how to Dynamically adjust Live 
Shapes and Live Lines in Adobe Illustrator using control widgets that let you modify the width, 
height, and corner radius properties.  

• Edit paths: learn about editing or reshaping paths using various tools in Adobe Illustrator. 

 

About color in Illustrator 
Applying colors to artwork is a common Adobe Illustrator task, and one that requires some 
knowledge of color models and color modes. When applying color to artwork, keep in mind the final 
medium in which the artwork will be published, so that you can use the correct color model and color 
definitions. Experimenting and applying color is easy using the feature-rich Swatches panel, Color 
Guide panel, and Edit Colors/Recolor Artwork dialog box in Illustrator. 

Color models describe the colors we see and work with in digital graphics. Each color model, such as 
RGB, CMYK, or HSB, represents a different method for describing and classifying color. Color models 
use numeric values to represent the visible spectrum of color. A color space is a variant of a color 
model and has a specific gamut (range) of colors. For example, within the RGB color model are a 
number of color spaces: Adobe® RGB, sRGB, and Apple® RGB. While each of these color spaces defines 
color using the same three axes (R, G, and B), their gamuts are different. 

About colors in digital graphics 

We use color models to describe the colors we see and work with in digital graphics. Each color 
model, such as RGB, CMYK, or HSB, represents a different method for describing and classifying color. 
Color models use numeric values to represent the visible spectrum of color. A color space is a variant 
of a color model and has a specific gamut (range) of colors. For example, within the RGB color model 
are a number of color spaces: Adobe® RGB, sRGB, and Apple® RGB. While each of these color spaces 
defines color using the same three axes (R, G, and B), their gamuts are different. 

When you work with the colors in a graphic, you are actually adjusting numerical values in the file. It’s 
easy to think of a number as a color, but these numerical values are not absolute colors in 
themselves—they only have a color meaning within the color space of the device that is producing the 
color. 

Because each device has its own color space, it can reproduce colors only in its gamut. When an image 
moves from one device to another, image colors may change because each device interprets the RGB 
or CMYK values according to its own color space. For example, it is impossible for all the colors 

https://helpx.adobe.com/illustrator/using/drawing-basics.html
https://helpx.adobe.com/content/help/en/illustrator/using/drawing-simple-lines-shapes.html
https://helpx.adobe.com/content/help/en/illustrator/using/pixel-perfect.html
https://helpx.adobe.com/content/help/en/illustrator/using/drawing-pen-pencil-or-flare.html
https://helpx.adobe.com/illustrator/how-to/live-shapes.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/advanced/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/content/help/en/illustrator/using/editing-paths.html
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viewed on a monitor to be identically matched in a print from a desktop printer. A printer operates in 
a CMYK color space, and a monitor operates in an RGB color space. Their gamuts are different. Some 
colors produced by inks cannot be displayed on a monitor, and some colors that can be displayed on 
a monitor cannot be reproduced using inks on paper. 

Even though it is impossible to perfectly match all colors on different devices, you can use color 
management to ensure that most colors are the same or similar enough so they appear consistent. 

RGB, CMYK, HSB, and Lab color models 

RGB 

A large percentage of the visible spectrum can be represented by mixing red, green, and blue (RGB) 
colored light in various proportions and intensities. Where the colors overlap, they create cyan, 
magenta, and yellow. 

RGB colors are called additive colors because you create white by adding R, G, and B together—that is, 
all light is reflected back to the eye. Additive colors are used for lighting, television, and computer 
monitors. Your monitor, for example, creates color by emitting light through red, green, and blue 
phosphors. 

 
Additive colors (RGB) 

R. Red G. Green B. Blue 

You can work with color values using the RGB color mode, which is based on the RGB color model. In 
RGB mode, each of the RGB components can use a value ranging from 0 (black) to 255 (white). For 
example, a bright red color might have an R value of 246, a G value of 20, and a B value of 50. When 
the values of all three components are equal, the result is a shade of gray. When the value of all 
components is 255, the result is pure white; when all components have values of 0, the result is pure 
black. 

Illustrator also includes a modified RGB color mode called Web Safe RGB, which includes only those 
RGB colors that are appropriate for use on the web. 

CMYK 

Whereas the RGB model depends on a light source to create color, the CMYK model is based on the 
light-absorbing quality of ink printed on paper. As white light strikes translucent inks, a portion of the 
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spectrum is absorbed. Color that is not absorbed is reflected back to your eye. 

Combining pure cyan (C), magenta (M), and yellow (Y) pigments would result in black by absorbing, 
or subtracting, all colors. For this reason they are called subtractive colors. Black (K) ink is added for 
better shadow density. (The letter K came into use because black is the “key” color for registering 
other colors, and because the letter B also stands for blue.) Combining these inks to reproduce color is 
called four-color process printing. 

 
Subtractive colors (CMYK) 

C. Cyan M. Magenta Y. Yellow K. Black 

You can work with color values using the CMYK color mode, which is based on the CMYK color 
model. In CMYK mode, each of the CMYK process inks can use a value ranging from 0 to 100%. The 
lightest colors are assigned small percentages of process ink colors; darker colors have higher 
percentage values. For example, a bright red might contain 2% cyan, 93% magenta, 90% yellow, and 
0% black. In CMYK objects, low ink percentages are closer to white, and high ink percentages are 
closer to black. 

Use CMYK when preparing a document to be printed using process inks. 

HSB 

Based on the human perception of color, the HSB model describes three fundamental characteristics 
of color: 

Hue 

Color reflected from or transmitted through an object. It is measured as a location on the standard 
color wheel, expressed as a degree between 0° and 360°. In common use, hue is identified by the 
name of the color, such as red, orange, or green. 

Saturation 

Strength or purity of the color (sometimes called chroma). Saturation represents the amount of gray in 
proportion to the hue, measured as a percentage from 0% (gray) to 100% (fully saturated). On the 
standard color wheel, saturation increases from the center to the edge. 

Brightness 

Relative lightness or darkness of the color, usually measured as a percentage from 0% (black) to 100% 
(white). 
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HSB color model 

H. Hue S. Saturation B. Brightness 

Lab 

The CIE Lab color model is based on the human perception of color. It is one of several color models 
produced by the Commission Internationale d’Eclairage (CIE), an organization dedicated to creating 
standards for all aspects of light. 

The numeric values in Lab describe all the colors that a person with normal vision sees. Because Lab 
describes how a color looks rather than how much of a particular colorant is needed for a device (such 
as a monitor, desktop printer, or digital camera) to produce colors, Lab is considered to be a device-
independent color model. Color management systems use Lab as a color reference to predictably 
transform a color from one color space to another color space. 

In Illustrator, you can use the Lab model to create, display, and output spot color swatches. However, 
you cannot create documents in Lab mode. 

Grayscale 

Grayscale uses tints of black to represent an object. Every grayscale object has a brightness value 
ranging from 0% (white) to 100% (black). Images produced using black-and-white or grayscale 
scanners are typically displayed in grayscale. 

Grayscale also lets you convert color artwork to high-quality black-and-white artwork. In this case, 
Adobe Illustrator discards all color information in the original artwork; the gray levels (shades) of the 
converted objects represent the luminosity of the original objects. 

When you convert grayscale objects to RGB, the color values for each object are assigned that object’s 
previous gray value. You can also convert a grayscale object to a CMYK object. 

Color spaces and gamuts 

A color space is a range of colors in the visible spectrum. A color space can also be a variant of a color 
model. Adobe RGB, Apple RGB, and sRGB are examples of different color spaces based on the same 
color model. 
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Gamuts of different color spaces 

A. Visual gamut B. RGB color space C. CMYK color space 

The range of color encompassed by a color space is called a gamut. The different devices (computer 
monitor, scanner, desktop printer, printing press, digital camera) throughout your workflow operate 
within different color spaces and each with different gamuts. Some colors within the gamut of your 
computer monitor are not within the gamut of your inkjet printer, and vice versa. When a color cannot 
be produced on a device, it’s considered to be outside the color space of that particular device. In 
other words, the color is out of gamut. 

About spot and process colors 

You can designate colors as either spot or process color types, which correspond to the two main ink 
types used in commercial printing. In the Swatches panel, you can identify the color type of a color 
using icons that appear next to the name of the color. 

When applying color to paths and frames, keep in mind the final medium in which the artwork will be 
published, so that you apply color using the most appropriate color mode. 

Note: If your color workflow involves transferring documents among devices, you may want to use a 
color-management system (CMS) to help maintain and regulate colors throughout the process. 

About spot colors 

A spot color is a special premixed ink that is used instead of, or in addition to, process inks, and that 
requires its own printing plate on a printing press. Use spot color when few colors are specified and 
color accuracy is critical. Spot color inks can accurately reproduce colors that are outside the gamut of 
process colors. However, the exact appearance of the printed spot color is determined by the 
combination of the ink as mixed by the commercial printer and the paper it’s printed on, not by color 
values you specify or by color management. When you specify spot color values, you’re describing the 
simulated appearance of the color for your monitor and composite printer only (subject to the gamut 
limitations of those devices). 

Keep the following guidelines in mind when specifying a spot color: 

• For best results in printed documents, specify a spot color from a color-matching system 
supported by your commercial printer. Several color-matching system libraries are included 
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with the software. 

• Minimize the number of spot colors you use. Each spot color you create will generate an 
additional spot color printing plate for a printing press, increasing your printing costs. If you 
think you might require more than four colors, consider printing your document using process 
colors. 

• If an object contains spot colors and overlaps another object containing transparency, 
undesirable results may occur when exporting to EPS format, when converting spot colors to 
process colors using the Print dialog box, or when creating color separations in an application 
other than Illustrator or InDesign. For best results, use the Flattener Preview or the Separations 
Preview to soft proof the effects of flattening transparency before printing. In addition, you can 
convert the spot colors to process colors by using the Ink Manager in InDesign before printing 
or exporting. 

• You can use a spot color printing plate to apply a varnish over areas of a process color job. In 
this case, your print job would use a total of five inks—four process inks and one spot varnish. 

About process colors 

A process color is printed using a combination of the four standard process inks: cyan, magenta, 
yellow, and black (CMYK). Use process colors when a job requires so many colors that using individual 
spot inks would be expensive or impractical, as when printing color photographs. 

Keep the following guidelines in mind when specifying a process color: 

• For best results in a high-quality printed document, specify process colors using CMYK values 
printed in process color reference charts, such as those available from a commercial printer. 

• The final color values of a process color are its values in CMYK, so if you specify a process color 
using RGB (or LAB, in InDesign), those color values will be converted to CMYK when you print 
color separations. These conversions differ based on your color-management settings and 
document profile. 

• Don’t specify a process color based on how it looks on your monitor, unless you are sure you 
have set up a color-management system properly, and you understand its limitations for 
previewing color. 

• Avoid using process colors in documents intended for online viewing only, because CMYK has 
a smaller color gamut than that of a typical monitor. 

• Illustrator and InDesign let you specify a process color as either global or non-global. In 
Illustrator, global process colors remain linked to a swatch in the Swatches panel, so that if you 
modify the swatch of a global process color, all objects using that color are updated. Non-
global process colors do not automatically update throughout the document when the color is 
edited. Process colors are non-global by default. In InDesign, when you apply a swatch to 
objects, the swatch is automatically applied as a global process color. Non-global swatches are 
unnamed colors, which you can edit in the Color panel. 

Note: Global and non-global process colors only affect how a particular color is applied to objects, 
never how colors separate or behave when you move them between applications. 

Using spot and process colors together 
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Sometimes it’s practical to use process and spot inks in the same job. For example, you might use one 
spot ink to print the exact color of a company logo on the same pages of an annual report where 
photographs are reproduced using process color. You can also use a spot color printing plate to apply 
a varnish over areas of a process color job. In both cases, your print job would use a total of five inks—
four process inks and one spot ink or varnish. 

In InDesign, you can mix process and spot colors together to create mixed ink colors. 

Comparing colors in InDesign and Illustrator 

Adobe InDesign and Adobe Illustrator use slightly different methods for applying named colors. 
Illustrator lets you specify a named color as either global or nonglobal, and InDesign treats all 
unnamed colors as nonglobal, process colors. 

The InDesign equivalents to global colors are swatches. Swatches make it easier to modify color 
schemes without having to locate and adjust each individual object. This is especially useful in 
standardized, production-driven documents like magazines. Because InDesign colors are linked to 
swatches in the Swatches panel, any change to a swatch affects all objects to which a color is applied. 

The InDesign equivalents to nonglobal swatches are unnamed colors. Unnamed colors do not appear 
in the Swatches panel, and they do not automatically update throughout the document when the 
color is edited in the Color panel. You can, however, add an unnamed color to the Swatches panel 
later. 

Named and unnamed colors only affect how a particular color updates in your document, never how 
colors separate or behave when you move them between applications. 

To learn more about color themes and related color options in Adobe Illustrator, we have provided 
links to the color sections of the Illustrator User Guide below. 

• Adjust colors: learn about adjusting, shifting, blending, and changing colors (including the tint 
of a global process color) in Adobe Illustrator. 

• Select colors: learn all about selecting colors for your artwork using a variety of tools, panels, 
and dialog boxes in Adobe Illustrator. 

• Use and create swatches: learn all about working with, creating, and managing swatches in 
Adobe Illustrator. 

• Color groups (harmonies): learn how to create color groups, and edit, assign, and reduce 
colors in Adobe Illustrator. 

 

Painting-related tools in Illustrator 
Check out the following sections of the Illustrator User Guide to learn how to use the painting-related 
tools in Illustrator. 

• Paint with fills and strokes: Learn about assigning, applying, or removing fill and stroke 
attributes when painting in Adobe Illustrator. 

• Live Paint groups: Learn all about converting your artwork to Live Paint groups in Adobe 
Illustrator. 

https://helpx.adobe.com/illustrator/user-guide.html?topic=/illustrator/morehelp/color.ug.js
https://helpx.adobe.com/content/help/en/illustrator/using/adjusting-colors.html
https://helpx.adobe.com/content/help/en/illustrator/using/selecting-colors.html
https://helpx.adobe.com/illustrator/using/using-creating-swatches.html
https://helpx.adobe.com/illustrator/using/color-groups-harmonies.html
https://helpx.adobe.com/content/help/en/illustrator/using/painting-fills-strokes.html
https://helpx.adobe.com/content/help/en/illustrator/using/live-paint-groups.html
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• Gradients: learn how to use gradients in Adobe Illustrator. 

• Brushes: Learn all about using, creating, and managing various brushes in Adobe Illustrator: 
calligraphic brushes, scatter brushes, pattern brushes, and more. 

• Transparency and blending modes: Learn about blending colors and adding transparency to 
artwork in Adobe Illustrator. 

For more information on painting-related tools scroll down to the “Learn More” section of the painting 
documentation. 

 

Select and Arrange Objects 
Listed below are the sections of the user guide that will teach you how to select and arrange objects in 
Illustrator. 

• Select objects: learn about making object-oriented selections using various tools in Adobe 
Illustrator. 

• Move, align, and distribute objects: learn about moving, aligning, and distributing objects in 
Adobe Illustrator. 

• Layers: learn about working with layers to organize and edit artwork in Adobe Illustrator. 

• Stack objects: learn about stacking objects in Adobe Illustrator. 

• Group and expand objects: learn about combining objects into groups in Adobe Illustrator. 

• Lock, hide, and delete objects: learn about locking, hiding, and deleting objects in Adobe 
Illustrator. 

• Duplicate objects: learn how to duplicate objects and selections.  

• Rotate and reflect objects: learn to change the orientation by rotating, reflecting, or flipping 
one or more objects in Adobe Illustrator. 

 

Reshape Objects 
This section covers the basics of reshaping and transforming objects in illustrator. 

• Transform objects: Learn about moving, rotating, reflecting, scaling, and shearing objects in 
Adobe Illustrator. 

• Combine objects: Learn about combining or merging vector objects to create shapes in Adobe 
Illustrator. 

• Scale, shear, and distort objects: Learn about scaling, shearing, and distorting objects using 
various tools and commands in Adobe Illustrator. 

• Edit clipping masks: Learn how to create and edit clipping masks and sets in Adobe Illustrator. 
A video tutorial is also included on this page. 

• Cut, divide, and trim objects: Learn about the different methods for cutting, dividing, and 

https://helpx.adobe.com/content/help/en/illustrator/using/gradients.html
https://helpx.adobe.com/content/help/en/illustrator/using/brushes.html
https://helpx.adobe.com/content/help/en/illustrator/using/transparency-blending-modes.html
https://helpx.adobe.com/illustrator/user-guide.html?topic=/illustrator/morehelp/painting.ug.js
https://helpx.adobe.com/illustrator/user-guide.html?topic=/illustrator/morehelp/painting.ug.js
https://helpx.adobe.com/content/help/en/illustrator/using/selecting-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/moving-aligning-distributing-objects.html
https://helpx.adobe.com/illustrator/using/layers.html
https://helpx.adobe.com/illustrator/using/stacking-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/grouping-expanding-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/locking-hiding-deleting-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/duplicating-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/rotating-reflecting-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/transforming-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/combining-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/scaling-shearing-distorting-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/clipping-masks.html
https://helpx.adobe.com/content/help/en/illustrator/using/cutting-dividing-objects.html
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trimming objects in Illustrator. 

• Blend objects: Learn about creating and working with blends in Adobe Illustrator. 

• Work with Live Corners: learn how to quickly reshape one or more corners of an object. 

• Create shapes using the Shape Builder tool: learn about making shapes with the Shape Builder 
tool. 

• Build new shapes with Shaper and Shape Builder tools: learn how to build shapes with the 
Shaper tool and how to set the Shape Builder tool options.  

For more information on various image adjustments you can make such as brightness/contrast 
adjustments, shadow and highlight detail adjustments, level adjustments, color balance adjustments, 
etc. scroll down to Learn More in the Image Adjustments section of the Photoshop User Guide. 

 

Type 
Watch the tutorial on how to work with type in Illustrator to give your students a quick overview of 
working with type. Then use the resources below to dive deeper into the specific type tools and text 
formatting options available in Illustrator. 

• Create text: learn about creating and working with type in Adobe Illustrator. 

• Create type on a path: learn about creating type on an open or closed path. 

• Import and export text: learn how to import and export text in Adobe Illustrator. 

• Fonts: learn about working with fonts in Adobe Illustrator. 

• Format paragraphs: learn all about formatting paragraphs. 

• Character and paragraph styles: learn about working with character and paragraph styles. 

• Format type: learn about formatting text, such as how to change appearance of characters, 
work with OpenType fonts, and more. 

• Line and character spacing: learn how to set the leading, shift the baseline, and adjust the 
kerning and tracking in Adobe Illustrator. 

 

Create Special Effects 
Illustrator includes a variety of effects, which you can apply to an object, group, or layer to change its 
characteristics. 

Illustrator CS3 and earlier included effects and filters, but now Illustrator includes only effects (with the 
exception of SVG Filters). The primary difference between a filter and an effect is that a filter 
permanently modifies an object or layer, but an effect and its properties can be changed or removed 
at any time. 

Once you apply an effect to an object, the effect appears in the Appearance panel. From the 
Appearance panel, you can edit the effect, move it, duplicate it, delete it, or save it as part of a graphic 

https://helpx.adobe.com/content/help/en/illustrator/using/blending-objects.html
https://helpx.adobe.com/content/help/en/illustrator/using/reshape-with-live-corners.html
https://helpx.adobe.com/illustrator/using/creating-shapes-shape-builder-tool.html
https://helpx.adobe.com/illustrator/using/building-new-shapes-using-shape.html
https://helpx.adobe.com/photoshop/user-guide.html
https://helpx.adobe.com/illustrator/how-to/work-with-type.html
https://helpx.adobe.com/content/help/en/illustrator/using/creating-text.html
https://helpx.adobe.com/content/help/en/illustrator/using/creating-type-path.html
https://helpx.adobe.com/content/help/en/illustrator/using/importing-exporting-text.html
https://helpx.adobe.com/content/help/en/illustrator/using/fonts.html
https://helpx.adobe.com/content/help/en/illustrator/using/formatting-paragraphs.html
https://helpx.adobe.com/content/help/en/illustrator/using/character-paragraph-styles.html
https://helpx.adobe.com/content/help/en/illustrator/using/formatting-type.html
https://helpx.adobe.com/content/help/en/illustrator/using/line-character-spacing.html
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style. When you use an effect, you must expand the object before you can access the new points. 

note: Previous versions of Illustrator included filters and effects. 

The effects in the top half of the Effects menu are vector effects. You can apply these effects only to 
vector objects or to the fill or stroke of a bitmap object in the Appearance panel. The following effects 
and effects categories from the top section are exceptions to this rule and can be applied to both 
vector and bitmap objects: 3D effects, SVG Filters, Warp effects, Transform effects, Drop Shadow, 
Feather, Inner Glow, and Outer Glow. 

The effects in the bottom half of the Effects menu are raster effects. You can apply them to either 
vector or bitmap objects. Visit the work with effects documentation to learn about applying, modifying 
and improving performance for effects in Adobe Illustrator. For additional information about effects in 
Adobe Illustrator refer to the resources below. 

• Graphic styles: learn how to create, apply, and import graphic styles in Adobe Illustrator 

• Appearance attributes: learn about working with and managing appearance attributes. 

• Create sketches and mosaics: learn how to create sketches and mosaics in Adobe Illustrator. 

• Create a drop shadow: learn how to apply a drop shadow effect to an object or group of 
objects. 

• Glows and feathering: learn how to apply glows and feathering to objects. 

• Summary of effects: this is a quick reference guide to the effects in Adobe Illustrator. 

 

Export Your Work 
When exporting your artwork, it is important to match the export settings to the project purpose. You 
can export your project assets in multiple sizes and formats depending on your needs. It is very 
important to understand which options and formats should be used for web, print, and video. For a 
quick overview of the various saving options watch this how to save a file for output tutorial. For a 
more detailed list of the different file formats and options available for exporting, see the export 
artwork documentation.  

Additionally, there is specific documentation on best practices for using Adobe Illustrator to create 
web graphics and artwork intended for printing available.  
  

https://helpx.adobe.com/content/help/en/illustrator/using/effects.html
https://helpx.adobe.com/content/help/en/illustrator/using/graphic-styles.html
https://helpx.adobe.com/content/help/en/illustrator/using/appearance-attributes.html
https://helpx.adobe.com/content/help/en/illustrator/using/creating-sketches-mosaics.html
https://helpx.adobe.com/content/help/en/illustrator/using/create-drop-shadow.html
https://helpx.adobe.com/content/help/en/illustrator/using/drop-shadows-glows-feathering.html
https://helpx.adobe.com/illustrator/using/summary-effects.html
https://helpx.adobe.com/illustrator/how-to/save-export-for-output.html
https://helpx.adobe.com/illustrator/how-to/save-export-for-output.html
https://helpx.adobe.com/illustrator/how-to/save-export-for-output.html
https://helpx.adobe.com/illustrator/user-guide.html?topic=/illustrator/morehelp/web_graphics.ug.js
https://helpx.adobe.com/illustrator/user-guide.html?topic=/illustrator/morehelp/web_graphics.ug.js
https://helpx.adobe.com/illustrator/user-guide.html?topic=/illustrator/morehelp/printing.ug.js
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Practice Tutorials and Files 
Below is a list of tutorials and resources from the Adobe Education Exchange and the Illustrator Learn 
& Support page that you can use in your classroom to prepare your students to be successful on the 
Visual Design Using Adobe Photoshop CC ACA exam.  

 

Create your first project 

Related objectives: Domain 1, Domain 2, and Domain 4 

This very simple set of three tutorials explains some basic design principles such as the difference 
between vector and raster images, then walks you through the steps of creating a document, creating 
basic shapes, and adding text to projects. 

Setup a new document 

Related objectives: Domain 2 

This tutorial goes describes in the options for configuring a new document in Adobe Illustrator for 
print, web, devices, video, and more in greater detail. 

Illustrator basics for new users 

Related objectives: Domain 3 and Domain 4 

This tutorial introduces students to the basic Illustrator tools and panels needed to create shapes, draw 
lines and curves, add and adjust type, manage colors, and organize assets using layers. 

Quickly manipulate shapes and effects 

Related objectives: Domain 3 and Domain 4 

Effects are a quick and easy way to manipulate shapes. Since effects are "live," you can return an 
altered shape to its original appearance afterwards. Learn how to create effects and experiment with 
variations in this tutorial. 

Draw and edit curves 

Related objectives: Domain 4 

In Exercise 5, the path has already been created. Use the Selection tool to select the path, and then 
switch to the Curvature tool. Drag the middle points to adjust their curves as shown. 

Create and apply patterns 

Related objectives: Domain 2 and Domain 4 

Learn how to create and apply patterns to many shapes in this tutorial, while experimenting with 
colors and shapes in patterns. 

Add painterly effects with brushes 

Related objectives: Domain 4 

Experiment with applying brush strokes to objects, adding texture, interest, and details to your 
illustration. 

http://edex.adobe.com/
https://helpx.adobe.com/illustrator/tutorials.html
https://helpx.adobe.com/illustrator/tutorials.html
https://helpx.adobe.com/illustrator/how-to/create-first-project.html?playlist=/ccx/v1/collection/product/illustrator/topics/basics/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/create-new-document.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/create-new-document.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/illustration-techniques.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/experiment-with-effects.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/experiment-with-effects.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/draw-edit-curves.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/draw-edit-curves.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/continuinged/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/create-apply-patterns.html?playlist=/ccx/v1/collection/product/illustrator/topics/pattern/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/create-apply-patterns.html?playlist=/ccx/v1/collection/product/illustrator/topics/pattern/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/brush-strokes.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/brush-strokes.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
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Draw with shapes, lines, and color 

Related objectives: Domain 1, Domains 2, Domain 4, and Domain 5  

Learn how to use the vector shape tools in Illustrator to create a striking illustration for any medium.  

Design a logo 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, Domain 5 

Use vector shapes to create a logo that looks good on screen and in print. Vector art scales to any 
size—from business cards to billboards—without losing quality. 

Create a web icon 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, and Domain 5 

Learn how to modify simple shapes to create standout icons for your blog, forms, digital documents, 
interactive projects, and more. 

Design a monogram 

Related objectives: Domain 1, Domain 2, Domain 3, Domain 4, Domain 5 

Use a simple shape, a professional typeface, and color to create a striking monogram. 

 

Check out additional projects, lesson plans, and teacher resources related to the ACA Photoshop 
exam on the Education Exchange. 

 
  

https://helpx.adobe.com/illustrator/how-to/draw-buildings.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/draw-buildings.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/basictraining/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/logo-design.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/logo-design.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/icon-design.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/icon-design.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/create-monogram.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://helpx.adobe.com/illustrator/how-to/create-monogram.html?playlist=/ccx/v1/collection/product/illustrator/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
https://edex.adobe.com/
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Sample Questions for the ACA Study Guides 
Illustrator CC 2015 

All sample questions have been provided by GMetrix. For information about full practice exams and 
additional exam preparation materials, visit GMetrix.com. 

Selected Response Questions 
1. What is the purpose for using 

hierarchy in design? 
a. It leads the viewer through the 

elements from graphics to text. 
b. It leads the viewer through the 

elements from brightest to 
darkest. 

c. It leads the viewer through the 
elements from side to side. 

d. It leads the viewer through the 
elements from most important 
to least important. 
 

2. If an image is divided into nine equal 
sections and you move the focal point 
to one of the intersecting areas, 
which rule of composition are you 
demonstrating? 

a. The rule of ninths 
b. The rule of thirds 
c. The 30-60-90 placement rule 
d. The non-symmetrical rule 

 
3. What is the definition of a vanishing 

point? 
a. The point at which colors no 

longer appear on a design 
b. The point at which two circles 

intersect 
c. The point at which receding 

parallel lines viewed in 
perspective appear to 
converge 

d. The point at which a linear 
gradient is transparent 

 
4. Which two tools are vector drawing 

tools? 
a. Pen tool 
b. Lasso tool 
c. Smooth tool 
d. Slice tool 

 
5. Which of the following would be a 

reason to add a bleed to your 
document? 

a. To add needed margins or 
padding to your document 

b. To compensate for printing in 
both the RGB and CMYK color 
spaces 

c. To allow for accurate color 
printing on various printer 
types 

d. To ensure that your artwork is 
still printed to the edge of the 
page after the page is trimmed 

 
6. Which of the following methods can 

you use to import an EPS file into 
your document? 

a. Open Command 
b. Place Command 
c. Paste Command 
d. Drag-and-Drop Feature 
e. All of the above 

 
7. Which two of the following describes 

the characteristics of typing on a 
path? 

http://gmetrix.com/
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a. The text flows along the edge 
of a closed path only 

b. The text flows along the edge 
of an open or closed path 

c. The text flows in the direction 
in which points were added to 
the path 

d. Text cannot be edited once it’s 
been added to a path 

8. Which tool is a vector drawing tool? 
a. Paintbrush 
b. Slice 
c. Width 
d. Gradient 

 
Simulation Questions 
When taking the actual exam, you will complete each of the tasks with your mouse in a simulated 
manner, but for this study guide we recommend that you practice by writing out the steps. In the space 
provided. 

 
1. Create a new web document named Aria Bakery that uses two artboards with the size 

1024x768. 

 

 

 

 

 

 

 

 

 

 

 

 
2. In the Pathfinder panel, remove the red arrow shape by combining the selected shapes using 

the Minus Front method. 
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3. Relink to the missing terapexLogo.png file, located in the Logo Images folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
4. Make the grid visible. 
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5. Create a sketched art image trace of the Duck image. 

 
 

 

 

 
  



Graphic Design & Illustration Using Adobe Illustrator CC 

 
Adobe, the Adobe logo, Adobe Photoshop and Creative Cloud are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. All other trademarks are the property of their respective owners. 
 
© 2017 Adobe Systems Incorporated. All rights reserved. 

25 

6. Rotate the pink rectangle to an angle of 255 degrees. 
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7. Left-align the text goat. 
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Scenario-Based Questions 
Scenario: A hobby store has hired you to create a banner that includes the company name and logo.  
They would like the flexibility to create banners in a variety of sizes. 

 
9. Which type of graphic should you use for the company name and logo to allow the 

company to print banners in a variety of sizes? 
a. Raster 
b. Vector 
c. Bitmap 

 
10. Set the tracking on the company’s name to be -50 (list steps). 

 

 

 

 

 

 

 
11. Open the Artistic_Ink brushes library. 
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Answer Key 
Selected-Response Questions 

1. d 
2. b 
3. c 
4. a and c 
5. d 
6. e 
7. b 
8. a 

Answer Key for Simulation Questions 
(answers below outline the steps to 
complete each simulation) 

Simulation 1 

1. Select the File menu 
2. Select New… 
3. Name it Aria Bakery 
4. In the Profile drop down menu, select Web 
5. For Number of Artboards, select or type 2 
6. In the Width textbox enter 1024 
7. In the Height textbox enter 768 
8. Click OK 

Simulation 2 

1. Select the Window menu 
2. Select Pathfinder 
3. In the Pathfinder panel, under the Shape 

Modes section, click the Minus Front button 

Simulation 3 

1. Select the terapexLogo.png image 
2. Select the Window menu 
3. Select Links 
4. In the Links dialog box, click the Relink icon 
5. Open the Logo Images folder 
6. Select the terapexLogo.png image 
7. Click Place 

Simulation 4  

1. Select the View menu 
2. Select Show Grid 

 

Simulation 5 
1. Select the Duck image 
2. Select the Sketched Art from the Image 

Trace drop down menu. 

Simulation 6 

1. Select the pink rectangle 
2. Open the Transform panel 
3. Change the rotation to 255 degrees 

OR 
1. Select the pink rectangle 
2. Select the Transform from the Object drop 

down menu 
3. Select Transform 
4. Change the rotation to 255 degrees 
5. Click OK 

Simulation 7 
1. Select the text goat 
2. In the Navigation bar, select Paragraph 
3. In the Paragraph drop down, select the Left-

align button 

Scenario-Based Questions 
1. b 
2. Answer: 

1. Select the company name 
2. In the Type bar, select Character 
3. Change the Tracking value to -50 

3. Answer:  
1. Select the Window menu 
2. Select Brushes 
3. Select Brush Libraries drop down menu 
4. Hover over Artistic and select 

Artistic_Ink 
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